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Chapter 1

Welcome
SMART Classroom Suite™ 2010 interactive learning software is a suite of SMART 

Technologies software for teachers and students. By using the suite with products 

such as a SMART Board™ interactive whiteboard, teachers can create highly 

interactive learning environments in their classrooms.

About this guide
This guide explains how to install SMART Classroom Suite software on your school’s 

computers, and how to configure and maintain the SMART Classroom Suite 

installation.

This guide is intended for IT administrators and others experienced with installing, 

configuring and administering Windows® software in a networked environment. To 

use this guide, you must:

• Know IT terminology such as “registry” and “domain controller”

• Know how to complete basic administrative tasks in Windows operating systems 

such as opening Control Panel or modifying the registry

• Have administrative privileges and access to your school’s servers

• Have the SMART Classroom Suite DVD or access to the SMART Support website

About SMART Classroom Suite
SMART Classroom Suite software integrates the following SMART Technologies 

software:

• SMART Notebook™ collaborative learning software

• SMART Notebook SE (Student Edition) collaborative learning software

• SMART Response™ CE assessment software

• SMART Sync™ classroom management software
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In addition, the suite includes SMART Product Drivers, Gallery content and a 30-day 

trial of SMART Notebook Math Tools.

SMART Notebook
SMART Notebook software enables teachers to create interactive lesson materials 

and present them to students using a SMART Board interactive whiteboard or other 

computer system. With a rich set of design and delivery features and access to 

Gallery content, SMART Notebook software connects teachers to content, tools and 

support for creating high-impact lessons for students.

SMART Notebook SE
SMART Notebook SE software helps students complete assignments, take notes, 

manage due dates and organize digital material. SMART Notebook SE software offers 

the same creative tools and features as SMART Notebook software, so it’s easy for 

teachers to share lesson notes and .notebook files with students.

SMART Response CE
SMART Response CE software allows teachers to gain insight into how well students 

understand lessons. Teachers can ask questions spontaneously during class, or they 

can prepare assessments in advance using SMART Notebook software.

SMART Sync
SMART Sync software helps teachers keep their students focused on learning. With 

SMART Sync, teachers can monitor and control student computers as well as 

facilitate collaboration.

Other components

SMART Product Drivers

SMART Product Drivers allow teachers’ computers to work with SMART Board 

interactive whiteboards or other SMART products. The drivers include the 

Floating Tools toolbar and other software tools teachers can use with their SMART 

products.

Gallery content

The Gallery, which is available in both SMART Notebook and SMART Notebook SE 

software, contains clip art, backgrounds, multimedia content, .notebook files and 

pages that teachers and students can use.
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Handwriting recognition installation packages

SMART Notebook software supports handwriting recognition in English by default. If 

you want to support handwriting recognition in a language other than English, you 

must download and install the installation package for the language. See page 7 for 

more information.

SMART Notebook Math Tools

SMART Notebook Math Tools is an add-in for SMART Notebook software. It includes 

mathematical features such as equation editing, handwriting recognition for 

mathematical terms, additional shape tools, measurement tools, graph generation 

and a launcher for Texas Instruments™ (TI) emulators. A 30-day trial is included, and 

you can activate SMART Notebook Math Tools using the product key you receive 

from SMART Technologies or your reseller to continue use of SMART Notebook Math 

Tools.

Example configuration
The following is an example configuration of SMART Classroom Suite’s components:
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In this example configuration:

• SMART Sync Class List Server is in a location on the school network that is 

accessible to the teacher, system administrator and student computers. The 

SMART School file is not accessible to students’ computers.

NOTE

For information on SMART School files, see page 70.

• A system administrator computer includes SMART Sync Administrator Tool.

• The teacher computer includes SMART Sync Teacher, SMART Response CE, 

SMART Notebook software and SMART Product Drivers, and is connected to a 

SMART Board interactive whiteboard.

• The student computers include SMART Sync Student and SMART Notebook SE 

software.

• The teacher and student computers are accessible to each other through the 

school network.
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Installing SMART 
Classroom Suite
You can install SMART Classroom Suite on your school’s computers using the 

installation wizard, the command line interface or SMART Install Manager 

(using Group Policy-based software deployment). Regardless of which tool you use, 

review the information in this chapter before proceeding with the installation.

Before installing SMART Classroom Suite
Before installing the suite, ensure your school’s computers meet the hardware and 

software requirements defined in the SMART Classroom Suite Release Notes 

(smarttech.com/kb/136910).

When you install SMART Classroom Suite, Windows Installer checks the computer for 

existing instances of the following components (all versions):

If Windows Installer finds instances of one or more of these components, it removes 

them, and then reinstalls them as part of the suite. (In the case of SMART Response 

or Senteo assessment software, Windows Installer installs SMART Response CE 

instead.)

IMPORTANT

• If you choose not to install a specific component of the suite but there is 

already an instance of the component on the computer, Windows Installer 

removes the component and does not reinstall it as part of the suite.

Teacher Student

• SMART Notebook software

• SMART Sync Teacher

• SMART Response or 

Senteo™ assessment software

• SMART Product Drivers

• SMART Notebook SE

• SMART Sync Student
 

http://www.smarttech.com/kb/136910
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• After you install the suite, do not install stand-alone instances of the suite’s 

component programs. If you attempt to install a stand-alone instance, the 

installation wizard detects the suite and does not let you continue.

NOTE

Only recently released versions of the component programs include this 

detection feature.

Selecting a tool
You can customize the SMART Classroom Suite installation packages using one of 

the following tools:

• Installation wizard

• Command line interface

• SMART Install Manager

Use the installation wizard if you’re installing SMART Classroom Suite on a small 

number of computers or if teachers and students are responsible for installing 

software on their own computers. For more information, see the SMART Classroom 

Suite 2010 Installation Guide (smarttech.com/kb/150908.

Use the command line interface if you prefer installing software using a command line 

interface rather than an GUI installation wizard, or if you use Windows Installer in 

conjunction with third-party remote management software to automate the installation 

of software across your school’s network. For more information, see page 9.

Use SMART Install Manager if you’re deploying SMART Classroom Suite across a 

large network of teacher and student computers and prefer to use SMART 

Install Manager, rather than a command line interface, to customize the installation 

packages. You can then use third-party software to automate the installation of 

software across your school’s network. For more information, see page 33.
 

http://www.smarttech.com/kb/150908
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Locating the installation packages
There are two installation packages (also known as MSI files) for SMART Classroom 

Suite:

Both installation packages are located on the SMART Classroom Suite DVD. The 

Teacher installation package is located in the Windows\Teacher folder, and the 

Student installation package is located in the Windows\Student folder.

Alternatively, you can go to smarttech.com/downloads, and then browse to the 

SMART Classroom Suite for Windows page to download these packages.

NOTE

SMART Notebook SE software includes handwriting recognition in English only. 

To use handwriting recognition with other languages, install SMART Product 

Drivers (included in the Teacher installation package) on student computers.

Handwriting recognition language installation packages
If you want to support handwriting recognition in a language other than English, you 

must download and install the installation package for that language.

Installation package File name

Teacher SMART Classroom Teacher.msi

Student SMART Classroom Student.msi

File Product code value

myscript hwr (arabic).msi {978A47F7-B01C-4E6B-8ED7-9C48DA5ED5D9}

myscript hwr (chinese).msi {1C08E9A9-AC34-41C1-82AE-28D052DBC500}

myscript hwr (danish).msi {5CAADAA8-39A6-44D4-A189-19A5DDB704AF}

myscript hwr (dutch).msi {FFE8B367-7349-406F-A583-F2795A0A0548}

myscript hwr (finnish).msi {7762637E-C185-4252-8FE9-72BC095AB47C}

myscript hwr (french).msi {9A960F35-C1DA-4FC0-B802-EAFF4179FDB0}

myscript hwr (german).msi {415CD877-0970-4CB6-B178-1E72F7DC60E7}

myscript hwr (greek).msi {DBBEDE5D-3342-4C13-ABA1-E35DA1147ED5}

myscript hwr (hungarian).msi {FB4F5116-0220-4296-B888-CBAFE6A6B9C0}

myscript hwr (italian).msi {0E5F9A13-4C27-4CE4-9E29-69223EE08FCF}

myscript hwr (japanese).msi {B693FD69-0E52-4BD6-B2BA-59EC10BB4BEF}

myscript hwr (korean).msi {5CBF713D-6EC6-4BDF-9B40-6338AC0D1C1A}
 

http://www.smarttech.com/downloads
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Go to smarttech.com/downloads, and then browse to the SMART Classroom Suite for 

Windows page to download these packages.

Adobe® Flash® Player Plug-Ins
The SMART Classroom Suite installation packages include Adobe Flash Player plug-

ins for the Internet Explorer® and Firefox® Internet browsers. Occasionally these 

plug-ins don’t install properly, and the user is prompted to download and install the 

plug-ins when they start SMART Notebook or SMART Response software. 

myscript hwr (norwegian).msi {12A35C25-B07E-4481-B1A0-B36892C07491}

myscript hwr (polish).msi {909E3219-72DE-40A3-9162-E653CBEBABF2}

myscript hwr (portuguese).msi {727822B6-9BF7-41C0-AB57-8EE6E21814D9}

myscript hwr (russian).msi {1F2282B4-7A07-4AD1-BFCF-C58F37E3EC2C}

myscript hwr (spanish).msi {EDAC6E0D-F93B-4B80-9377-F57D3BB5E6B1}

myscript hwr (swedish).msi {EB61ED3F-8C2F-4D3D-81BE-CA16DA87D515}

myscript hwr (turkish).msi {319B07E6-4D8A-4A7F-BC38-BA39C4BADF4F}

File Product code value
 

http://www.smarttech.com/downloads
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Using the 
command line 
interface
SMART Classroom Suite installation packages contain all of the information 

Windows Installer requires to install or remove the SMART Classroom Suite 

components. Run the MSI files from the Command Prompt to start Windows Installer 

and install or modify the software using available properties and parameters.

Completing Teacher installation tasks
Using the Teacher installation package, you can complete the following tasks from a 

command line interface:

• Installing or upgrading Teacher components

• Removing Teacher components
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Installing or upgrading Teacher components
You can install or upgrade the Teacher components of SMART Classroom Suite 

software by following the instructions in this section.

To install or upgrade

Teacher components

1. Open the Command Prompt window.

2. Type the following command:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
[Properties] [Parameter] 

Where:

– [Path] is the path to the SMART Classroom Teacher.msi file or the 

handwriting recognition MSI file.

– [Properties] is a set of properties you can include to customize the installation 

(see page 12).

– [Parameter] is the installation parameter (see page 29).

3. Press ENTER.

Windows Installer installs or upgrades the Teacher components.

Removing Teacher components
In addition to installing or upgrading Teacher components of SMART Classroom Suite 

software, you can remove them in Silent mode using Windows Installer.

To remove

Teacher components

1. Open the Command Prompt window.

2. Type the following command:

msiexec.exe /x "[Path]\SMART Classroom Teacher.msi" /q

Where [Path] is the path to the SMART Classroom Teacher.msi file.

3. Press ENTER.

Windows Installer removes the Teacher components.

NOTE

This can take several minutes with no indication of activity or completion.
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Completing Student installation tasks
Using the Student installation package, you can complete the following tasks from a 

command line interface:

• Installing or upgrading Student components

• Removing Student components

Installing or upgrading Student components
You can install or upgrade the Student components of SMART Classroom Suite 

software by following the instructions in this section.

To install or upgrade

Student components

1. Open the Command Prompt window.

2. Type the following command:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
[Properties] [Parameter] 

Where:

– [Path] is the path to the SMART Classroom Student.msi file.

– [Properties] is a set of properties in the form [Property]="[Value]" that you can 

include to customize the installation (see page 20).

– [Parameter] is the installation parameter (see page 29).

3. Press ENTER.

Windows Installer installs or upgrades the Student components.
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Removing Student components
In addition to installing or upgrading Student components of SMART Classroom Suite 

software, you can remove them in Silent mode using Windows Installer.

To remove

Student components

1. Open the Command Prompt window.

2. Type the following command:

msiexec.exe /x "[Path]\SMART Classroom Student.msi" /q

Where [Path] is the path to the SMART Classroom Student.msi file.

3. Press ENTER.

Windows Installer removes the Student components.

NOTE

This can take several minutes with no indication of activity or completion.

Properties

Teacher installation package

General

The following are general properties for the Teacher installation package:

• INSTALLDIR 

NOTE

If you don’t include this property, Windows Installer installs the programs in 

%PROGRAMFILES%\SMART Technologies\Classroom Teacher.

• ISX_SERIALNUM 

Value Enter this value to:

[String] Specify the path to your preferred folder for the 

SMART Classroom Suite Teacher programs.

Value Enter this value to:

[String] Specify the 22-character product key you received from 

SMART Technologies.
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• ACTIVATE_LICENSE 

• INSTALL_NOTEBOOK 

• INSTALL_RESPONSE 

• INSTALL_BOARD 

• INSTALL_SYNC 

• INSTALL_CLASSLIST_SERVER 

Value Enter this value to:

1 (Default) Start the activation wizard automatically after the installation 

process completes.

0 Not start the activation wizard automatically after the 

installation process completes.

Value Enter this value to:

1 (Default) Install SMART Notebook software.

0 Not install SMART Notebook software.

Value Enter this value to:

1 (Default) Install SMART Response CE.

0 Not install SMART Response CE.

Value Enter this value to:

1 (Default) Install SMART Product Drivers.

0 Not install SMART Product Drivers.

Value Enter this value to:

1 (Default) Install SMART Sync Teacher.

0 Not install SMART Sync Teacher.

Value Enter this value to:

1 Install SMART Sync Class List Server.

0 (Default) Not install SMART Sync Class List Server.
 



14 | CHAPTER 3  –  USING THE COMMAND LINE INTERFACE
• INSTALL_ADMIN_TOOLS 

• NBPLUGIN_INSTALLED

IMPORTANT

If you have a security policy restricting the installation of any Internet Explorer 

ActiveX® plug-ins (32-bit operating systems), you need to include 

NBPLUGIN_INSTALLED=0 or the installation might not succeed.

NOTE

By default, this plug-in isn’t installed on 64-bit systems.

• INSTALL_DOCCAM_DRIVERS

• INSTALL_SPU 

• SPU_TIME_FRAME 

NOTES

– By default, SPU checks for product updates every 30 days. You can set 

SPU to check for product updates at intervals of 1 to 60 days.

– This property is applicable only if you install SPU.

Value Enter this value to:

1 Install SMART Sync Administrator Tool.

0 (Default) Not install SMART Sync Administrator Tool.

Value Enter this value to:

1 (Default) Install the NotebookPlugin.dll file and add the associated 

registry keys.

0 Install the NotebookPlugin.dll file without adding the 

associated registry keys.

Value Enter this value to:

1 (Default) Install SMART Document Camera drivers

0 Not install SMART Document Camera drivers

Value Enter this value to:

1 (Default) Install SMART Product Update (SPU).

0 Not install SPU.

Value Enter this value to:

[Integer] Specify the time in days between SPU checks.
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• PRODUCT_NOTIFICATION 

NOTE

This property is applicable only if you install SPU.

• ENABLE_MATH_TRIAL

• TRANSFORMS

NOTE

The TRANSFORMS property defines the language of the installer’s user 

interface and the installed software’s icons and shortcuts. It doesn’t define the 

installed software’s user interface language. The installed software uses the 

computer’s operating system language if it’s supported, or English (U.S.) if it 

isn’t.

Value Enter this value to:

1 (Default) Notify the user when updates are available from SPU.

0 Not notify the user when updates are available from SPU.

Value Enter this value to:

1 (Default) Enable a 30-day trial of SMART Notebook Math Tools.

0 Disable the 30-day trial of SMART Notebook Math Tools.

Value Enter this value to install Teacher programs in:

1033.mst English (U.S.)

2057.mst English (UK)

1024.mst Arabic

2052.mst Chinese (Simplified)

1029.mst Czech

1030.mst Danish

1043.mst Dutch

1035.mst Finnish

1036.mst French

1031.mst German

1032.mst Greek

1038.mst Hungarian

1040.mst Italian

1024.mst Korean
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• CREATE_DESKTOP_ICONS 

• ACC 

1044.mst Norwegian

1045.mst Polish

2070.mst Portuguese (Portugal)

1046.mst Portuguese (Brazil)

1049.mst Russian

1034.mst Spanish (Spain)

2058.mst Spanish (Mexico)

1053.mst Swedish

1055.mst Turkish

Value Enter this value to:

1 (Default) Include desktop shortcuts to SMART Sync Teacher and 

SMART Notebook software.

0 Not include desktop shortcuts to SMART Sync Teacher and 

SMART Notebook software.

Value Enter this value to:

0 Disable Internet access.

1 Enable Internet access for Gallery Setup only.

2 Enable Internet access for Language Setup only.

3 Enable Internet access for Gallery Setup and Language 

Setup only.

4 Enable Internet access for SPU only.

5 Enable Internet access for Gallery Setup and SPU only.

6 Enable Internet access for Language Setup and SPU only.

7 Enable Internet access for everything except the Customer 

Experience Program.

8 Enable Internet access for the Customer Experience 

Program only.

9 Enable Internet access for Gallery Setup and the Customer 

Experience Program only.

Value Enter this value to install Teacher programs in:
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SMART Sync Teacher

The following property is applicable if you choose to install SMART Sync Teacher (see 

page 13):

• SCHOOLFILE 

NOTE

Before you can specify the path to a SMART School file, you must install 

SMART Sync Administrator Tool (see page 14), and then use it to create the 

SMART School file (see page 70).

SMART Notebook software

The following properties are available if you choose to install SMART Notebook 

software (see page 13):

• NETWORK_CONTENT, CONTENT_SOURCE_PATH, 

CONTENT_TARGET_PATH, FULL_GALLERY and *_CONTENT 

For information on these properties, see page 51.

10 Enable Internet access for Language Setup and the 

Customer Experience Program only.

11 Enable Internet access for everything except SPU.

12 Enable Internet access only for SPU and the Customer 

Experience Program.

13 Enable Internet access for everything except Language 

Setup.

14 Enable Internet access for everything except Gallery Setup.

15 (Default) Enable Internet access for everything.

Value Enter this value to:

[String] Specify the full path to, and name of, the SMART School 

file.

Value Enter this value to:
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• TEAM_CONTENT_PATH

NOTE

A Team Content folder is a location on your school network where teachers 

and students can store shared content.

• MY_CONTENT

NOTE

A My Content folder is a location on the teacher computer where the teacher 

can store individual content.

• PRINT_CAPTURE 

NOTE

The Print Capture Driver is a printer driver that enables teachers to import 

content from other programs into SMART Notebook software.

Value Enter this value to:

[Path] Specify the path to the folder where you want to save team 

content. 

IMPORTANT

You must specify a path to an existing folder in this 

property. See Changing Gallery content locations on 

page 60 for information on creating or changing the 

location of Team Content folders.

Value Enter this value to:

[Path] Specify the path to the user’s folder where you want the 

My Content folder to appear. 

TIP

You can use environment variables in this path. This is 

useful if you want to store content on a shared network 

folder so users can access their My Content folder from 

any computer on your network.

Value Enter this value to:

1 (Default) Install the Print Capture driver.

0 Not install the Print Capture driver.
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• CUSTOMER_LOGGING

SMART Product Drivers

The following properties are available if you choose to install SMART Product Drivers 

(see page 13):

• TOOLS_STARTUP_GROUP 

• ENABLE_TABLETPC_SUPPORT 

NOTE

This property is applicable only for the Windows Vista® and Windows 7 

operating systems. It has no effect on other operating systems.

• START_SNMP_SERVICE 

NOTE

For more information on SMART SNMP Agent, see the SMART SNMP Agent 

Administrator’s Guide (smarttech.com/kb/150907).

Value Enter this value to:

0 Disable the Customer Experience Program.

1 (Default) Allow the teacher to enable or disable the Customer 

Experience Program.

2 Enable the Customer Experience Program.

Value Enter this value to:

1 (Default) Start SMART Tools when the teacher logs on.

0 Not start SMART Tools when the teacher logs on.

Value Enter this value to:

1 (Default) Use Tablet PC functionality with the SMART Board 

interactive whiteboard without connecting a Tablet PC.

0 Not use Tablet PC functionality with the SMART Board 

interactive whiteboard without connecting a Tablet PC.

Value Enter this value to:

1 Enable SMART SNMP Agent, allowing you to remotely 

monitor and control your SMART products and projectors 

from a central location.

0 (Default) Disable SMART SNMP Agent.
 

http://www.smarttech.com/kb/150907
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SMART Response CE

The following properties are available if you choose to install SMART Response CE 

(see page 13):

• LAUNCH_RESPONSE_DESKTOP_MENU 

• CERTIFICATE_FOLDER

• FILE_PORT

• SECURE_BASE_PORT

Student installation package

General

The following are general properties for the Student installation package:

• INSTALLDIR 

NOTE

If you don’t include this property, Windows Installer installs the programs in 

%PROGRAMFILES%\SMART Technologies\Classroom Student.

Value Enter this value to:

1 (Default) Add the SMART Response icon to the notification area 

when the teacher logs on.

0 Not add the SMART Response icon to the notification area 

when the teacher logs on.

Value Enter this value to:

[String] Specify the path to, and file name of, the security certificate 

for Diffie-Hellman encryption (see page 65).

Value Enter this value to:

[String] Specify the port you want to use to send assessment 

information to SMART Notebook SE software.

Value Enter this value to:

[String] Specify the secure port you want to use to receive 

assessment information from SMART Notebook SE 

software. 

Value Enter this value to:

[String] Specify the path to your preferred folder for the 

SMART Classroom Suite Student programs.
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• ISX_SERIALNUM 

• ACTIVATE_LICENSE 

• INSTALL_SYNC 

• INSTALL_NBSE 

• NBPLUGIN_INSTALLED

IMPORTANT

If you have a security policy restricting the installation of any Internet Explorer 

ActiveX plug-ins (32-bit operating systems), you need to include 

NBPLUGIN_INSTALLED=0 or the installation might not succeed.

NOTE

By default, this plug-in isn’t installed on 64-bit systems.

Value Enter this value to:

[String] Specify the 22-character product key you received from 

SMART Technologies.

Value Enter this value to:

1 (Default) Start the activation wizard automatically after the installation 

process completes.

0 Not start the activation wizard automatically after the 

installation process completes.

Value Enter this value to:

1 (Default) Install SMART Sync Student.

0 Not install SMART Sync Student.

Value Enter this value to:

1 (Default) Install SMART Notebook SE software.

0 Not install SMART Notebook SE software.

Value Enter this value to:

1 (Default) Install the NotebookPlugin.dll file and add the associated 

registry keys.

0 Install the NotebookPlugin.dll file without adding the 

associated registry keys.
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• INSTALL_SPU 

• SPU_TIME_FRAME 

NOTES

– By default, SPU checks for product updates every 30 days. You can set 

SPU to check for product updates at intervals of 1 to 60 days.

– This property is applicable only if you install SPU.

• PRODUCT_NOTIFICATION 

NOTE

This property is applicable only if you install SPU.

• CREATE_DESKTOPICONS 

NOTE

If you set SYNC_VISIBLE to 0, this property is overridden.

Value Enter this value to:

1 (Default) Install SPU.

0 Not install SPU.

Value Enter this value to:

[Integer] Specify the time in days between SPU checks.

Value Enter this value to:

1 (Default) Notify the user when updates are available from SPU.

0 Not notify the user when updates are available from SPU.

Value Enter this value to:

1 (Default) Include desktop shortcuts to SMART Sync Student and 

SMART Notebook SE software.

0 Not include desktop shortcuts to SMART Sync Student and 

SMART Notebook SE software.
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• TRANSFORMS

NOTE

The TRANSFORMS property defines the language of the installer’s user 

interface and the installed software’s icons and shortcuts. It doesn’t define the 

installed software’s user interface language. The installed software uses the 

computer’s operating system language if it’s supported, or English (U.S.) if it 

isn’t.

Value Enter this value to install Student programs in:

1033.mst English (U.S.)

2057.mst English (UK)

1025.mst Arabic

2052.mst Chinese (Simplified)

1029.mst Czech

1030.mst Danish

1043.mst Dutch

1035.mst Finnish

1036.mst French

1031.mst German

1032.mst Greek

1038.mst Hungarian

1040.mst Italian

1042.mst Korean

1044.mst Norwegian

1045.mst Polish

2070.mst Portuguese (Portugal)

1046.mst Portuguese (Brazil)

1049.mst Russian

1034.mst Spanish (Spain)

2058.mst Spanish (Mexico)

1053.mst Swedish

1055.mst Turkish
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• ACC 

SMART Sync Student

The following properties are available if you choose to install SMART Sync Student 

(see page 21):

• PATHTOINI 

NOTES

Value Enter this value to:

0 Disable Internet access.

1 Enable Internet access only for Gallery Setup.

2 Enable Internet access only for Language Setup.

3 Enable Internet access only for Gallery Setup and 

Language Setup.

4 Enable Internet access for SPU only.

5 Enable Internet access for Gallery Setup and SPU only.

6 Enable Internet access for Language Setup and SPU only.

7 Enable Internet access for everything except the Customer 

Experience Program.

8 Enable Internet access for the Customer Experience 

Program only.

9 Enable Internet access for Gallery Setup and the Customer 

Experience Program only.

10 Enable Internet access for Language Setup and the 

Customer Experience Program only.

11 Enable Internet access for everything except SPU.

12 Enable Internet access for SPU and the Customer 

Experience Program only.

13 Enable Internet access for everything except Language 

Setup.

14 Enable Internet access for everything except Gallery Setup.

15 (Default) Enable Internet access for everything.

Value Enter this value to:

[String] Specify the path to the SyncClient.ini file.
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– If you installed the SMART Sync Administrator Tool (see page 14), you 

can use the SMART Sync Student Configuration Tool to create a 

SyncClient.ini file, which you can then refer to in this property (see 

page 83).

– If you don’t include this property, Windows Installer refers to the 

SyncClient.ini file in the same folder as the MSI file. If Windows Installer 

doesn’t find a SyncClient.ini file in this folder, it uses a default 

SyncClient.ini file.

• SYNC_VISIBLE 

• SYNC_CONTEACHID

IMPORTANT

– If you set SYNC_VISIBLE to 0, you must include this property, 

SYNC_CONNECTIP or SYNC_NAMINGSERVERLOC.

– If you include this property, do not include SYNC_CONNECTIP and 

SYNC_NAMINGSERVERLOC.

• SYNC_CONNECTIP

IMPORTANT

– If you set SYNC_VISIBLE to 0, you must include this property, 

SYNC_CONTEACHID or SYNC_NAMINGSERVERLOC.

– If you include this property, do not include SYNC_CONTEACHID and 

SYNC_NAMINGSERVERLOC.

• SYNC_NAMINGSERVERLOC

IMPORTANT

– If you set SYNC_VISIBLE to 0, you must include this property, 

SYNC_CONTEACHID or SYNC_CONNECTIP.

Value Enter this value to:

1 (Default) Show the SMART Sync Student user interface to the user.

0 Hide the SMART Sync Student user interface from the user.

Value Enter this value to:

[String] Specify a teacher ID to which SMART Sync will connect 

automatically.

Value Enter this value to:

[String] Specify a teacher host name or IP address to which SMART 

Sync will connect automatically.
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– If you include this property, do not include SYNC_CONTEACHID and 

SYNC_CONNECTIP.

• SYNC_AUTOSTART

IMPORTANT

This property is applicable only if you set SYNC_VISIBLE to 1.

• SYNC_ENABLEQUESTIONS

IMPORTANT

This property is applicable only if you set SYNC_VISIBLE to 1.

• SYNC_ENABLECHAT

NOTE

This property is applicable only if you set SYNC_VISIBLE to 1.

• SYNC_ENABLEFILETRANSFER

Value Enter this value to:

[String] Specify a teacher host name or IP address to which SMART 

Sync will connect automatically.

Value Enter this value to:

1 (Default) Start SMART Sync when the student first logs on.

0 Not start SMART Sync when the student first logs on.

Value Enter this value to:

1 (Default) Allow the student to ask questions through SMART Sync.

0 Not allow the student to ask questions through SMART 

Sync.

Value Enter this value to:

1 (Default) Allow the student to chat with other students through 

SMART Sync.

0 Not allow the student to chat with other students through 

SMART Sync.

Value Enter this value to:

1 (Default) Allow the student to submit files through SMART Sync.

0 Not allow the student to submit files through SMART Sync.
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NOTE

This property is applicable only if you set SYNC_VISIBLE to 1.

• SYNC_DISPLAYEXIT

NOTE

This property is applicable only if you set SYNC_VISIBLE to 1.

• SYNC_STUDIDMODE

NOTES

– If you set SYNC_VISIBLE to 1, this property’s default value is 2.

– If you set SYNC_VISIBLE to 0, this property’s default value is 1. In this 

situation, you must include SYNC_STUDENTID.

• SYNC_STUDENTID

NOTE

If you include this property, SYNC_STUDIDMODE is set to 1 automatically.

• SYNC_ACTDIRSTUDID

NOTES

If you include this property, SYNC_STUDIDMODE is set to 0 automatically.

Value Enter this value to:

1 Allow the student to close SMART Sync.

0 (Default) Not allow the student to close SMART Sync.

Value Enter this value to:

0 Use a student ID found in an Active Directory® directory 

service field specified in SYNC_ACTDIRSTUDID.

1 Use a student ID specified in SYNC_STUDENTID.

2 Allow the student to enter an ID when SMART Sync Student 

starts.

3 Allow the student to use SMART Sync Student without 

entering an ID.

Value Enter this value to:

[String] Specify a student ID.

Value Enter this value to:

[String] Specify the name or ID of an Active Directory directory 

service field that contains the student’s ID.
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• SYNC_CUSTSHRDFOLDER

NOTE

SMART Sync opens folders with the full Universal Naming Convention (UNC) 

path. However, students are unable to navigate to and access parent folders.

SMART Notebook SE software

The following properties are available if you choose to install SMART Notebook SE 

software (see page 21):

• NETWORK_CONTENT, CONTENT_SOURCE_PATH, 

CONTENT_TARGET_PATH, FULL_GALLERY and *_CONTENT 

For information on these properties, see page 51.

• TEAM_CONTENT_PATH

NOTES

– A Team Content folder is a location on your school’s network where 

teachers and students can store shared content.

– For information on creating a Team Content folder, see page 62.

• MY_CONTENT

Value Enter this value to:

0 (Default) Store files the teacher shares with the student in the 

My Documents folder.

[String] Store files the teacher shares with the student in another 

folder specified in this property.

Value Enter this value to:

[Path] Specify the path to the folder where you want to save team 

content. 

IMPORTANT

You must specify a path to an existing folder in this 

property. See Changing Gallery content locations on 

page 60 for information on creating or changing the 

location of Team Content folders.

Value Enter this value to:

[Path] Specify the path to the user’s folder where you want the 

My Content folder to appear. 
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TIP

You can use environment variables in this path. This is useful if you want to 

store content on a shared network folder so users can access their 

My Content folder from any computer on your network.

NOTE

– A My Content folder is a location on the student computer where the 

student can store individual content.

– For information on My Content folders, see page 62.

• BINDERSELECTEDOPT 

• BINDERDIR 

• CUSTOMER_LOGGING 

Parameters
The following are parameters for the Teacher and Student installation packages:

Value Enter this value to:

ApplicationData 

(Default)

Place Binder files in %USERPROFILE%\Application Data.

MyDocuments Place Binder files in %USERPROFILE%\My Documents.

Other Place Binder files in a folder specified in the BINDERDIR 

property.

Value Enter this value to:

[String] Specify the path to a folder where you want to place Binder 

files (if you set the BINDERSELECTEDOPT to Other).

Value Enter this value to:

0 Disable the Customer Experience Program.

1 (Default) Allow the student to enable or disable the 

Customer Experience Program.

2 Enable the Customer Experience Program.

Parameter Use this parameter to:

/q Hide the installation wizard.

NOTE

This is Silent mode.
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Examples

Teacher installation package
This example installs all Teacher programs (except SMART Sync Class List Server 

and SMART Sync Administrator Tool) with default settings in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" /q

This example installs all Teacher programs except SMART Response CE with default 

settings in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
INSTALL_RESPONSE="0" INSTALLCLASSLISTSERVER="1" 
INSTALLADMINTOOL="1" /q

This example installs all Teacher programs (except SMART Sync Class List Server 

and SMART Sync Administrator Tool) in Silent mode, specifying central locations on 

the school’s network for Gallery content and the Team Content folder:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
NETWORK_CONTENT="1" CONTENT_TARGET_PATH="\\server\gallery\" 
TEAM_CONTENT_PATH="\\server\teamcontent\" /q

/qb Show a basic installation wizard.

/qb! Show a basic installation wizard without a Cancel button.

/qb+ Show a basic installation wizard with a dialog box signaling the 

end of the installation.

/qb+! Show a basic installation wizard without a Cancel button but 

with a dialog box signaling the end of the installation.

/qr Show a reduced installation wizard.

/qf Show the full installation wizard, including a dialog box signaling 

the end of the installation or the Fatal Error, User Exit or Exit 

dialog box.

/qn Hide the installation wizard and the dialog box signaling the end 

of the installation.

/qn+ Hide the installation wizard but show the dialog box signaling 

the end of the installation.

Parameter Use this parameter to:
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This example installs all Teacher programs (except SMART Sync Class List Server 

and SMART Sync Administrator Tool) and the Geography and History categories of 

the Gallery Essentials collection in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
FULL_GALLERY="0" GEOGRAPHY_CONTENT="1" HISTORY CONTENT="1" /
q

This example installs all Teacher programs (except SMART Sync Class List Server 

and SMART Sync Administrator Tool), displaying the installation wizard in German:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
TRANSFORMS="1031.mst" /qb

This example installs all Teacher programs (except SMART Sync Class List Server 

and SMART Sync Administrator Tool) in Silent mode, enabling the Customer 

Experience Program by default:

msiexec.exe /i "[Path]\SMART Classroom Teacher.msi" 
CUSTOMER_LOGGING="2" /q

Student installation package
This example installs all Student programs with default settings in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" /q

This example installs all Student programs except SMART Sync with default settings 

in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
INSTALL_SYNC="0" /q

This example installs all Student programs in Silent mode, specifying central locations 

on the school network for Gallery content and the Team Content folder:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
NETWORK_CONTENT="1" CONTENT_TARGET_PATH="\\server\gallery\" 
TEAM_CONTENT_PATH="\\server\teamcontent\" /q

This example installs all Student programs and the Science and Technology and 

History categories of the Gallery Essentials collection in Silent mode:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
FULL_GALLERY="0" SCIENCE_CONTENT="1" HISTORY CONTENT="1" /q
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This example installs all Student programs, displaying the installation wizard in Arabic:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
TRANSFORMS="3084.mst" /qb

This example installs all Student programs in Silent mode, enabling the Customer 

Experience Program by default:

msiexec.exe /i "[Path]\SMART Classroom Student.msi" 
CUSTOMER_LOGGING="2" /q
 



Chapter 4

Using SMART 
Install Manager
SMART Install Manager enables you to customize the SMART Classroom Suite 

installation packages (also known as .msi files) by publishing MST files. You can then 

install the MSI and MST files on the teacher and student computers using Group 

Policy-based software deployment.

Installing SMART Install Manager
You can install SMART Install Manager from the SMART Classroom Suite DVD.

OR

You can download and install SMART Install Manager from smarttech.com/software.

To install the software

from the DVD

1. Insert the SMART Classroom Suite DVD in your computer’s DVD drive.

The SMART Classroom Suite dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open 

[DVD Drive]\CDBrowser.exe in Windows Explorer.

2. Click Administrator Preparation and Tools, and then click 

Install SMART Install Manager.

The SMART Install Manager installation wizard appears.

3. Follow the on-screen instructions to install SMART Install Manager.
 

http://www.smarttech.com/software
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To install the software

from the website

1. Go to smarttech.com/software, and then browse to the SMART Classroom Suite 

for Windows page.

2. Click Download under the SMART Install Manager heading and follow the 

on-screen instructions to download the SMART Install Manager installation wizard 

to your computer.

3. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

4. Follow the on-screen instructions to install SMART Install Manager.

Working with SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the 

desktop and in the Start menu under All Programs > SMART Technologies > 

SMART Install Manager.

With SMART Install Manager, you can do the following:

• Open an installation package

• Save your changes to the installation package

• Publish your changes to the installation packages as an MST file

Opening an installation package
To customize an installation package, open its MSI file in SMART Install Manager by 

doing one of the following:

• Select File > Open

• Click 

• Drag the MSI file into the SMART Install Manager window

Alternatively, you can search for installation packages on your computer by 

clicking , or on CDs or DVDs by clicking .

TIP

All installation packages you’ve previously opened in SMART Install Manager 

appear in the Unmodified Packages tab.

After you open an installation package, a set of pages for that installation package 

appears in SMART Install Manager.
 

http://www.smarttech.com/software
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You can customize the installation package using the controls in these pages. See 

below for information on the Teacher installation package controls and page 40 for 

information on the Student installation package controls.

Saving your changes
After you customize an installation package, you can save your changes as an XML 

file by selecting File > Save As. When you next start SMART Install Manager, you can 

load the XML file by selecting File > Open, or by opening the MSI file, and then 

selecting File > Import.

TIP

All XML files you create or open in SMART Install Manager appear in the 

Modified Packages tab of the Welcome page.

Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is 

to publish your changes as an MST file. Do this by selecting File > Publish, and then 

using the dialog box to define a location for and to create the MST file.

TIP

Publish the MST file in the same network location as the MSI file.

Customizing the Teacher 
installation package
Open the SMART Classroom Teacher.msi file in SMART Install Manager 

(see page 34), and then complete the procedures in the following sections.

Setting general options
By completing the procedures in this section, you define which Teacher programs you 

want to include in the installation and set the following options:

• The folder for the Teacher programs

• The product key

• Whether to activate the software during installation or afterward

• SMART Product Update (SPU) preferences
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To set

installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for the 

SMART Classroom Suite Teacher programs.

NOTE

If you don’t specify a folder, Windows Installer installs the programs in 

%PROGRAMFILES%\SMART Technologies\Classroom Teacher.

3. In the Product key box, type your school’s 22-character product key for 

SMART Classroom Suite software.

4. Select the Activate SMART Classroom Suite during installation check box to 

activate SMART Classroom Suite software automatically during installation rather 

than manually after installation.

NOTE

To activate the suite automatically during installation, you must provide a 

product key.

5. Define which programs you want to include in the installation by selecting the 

appropriate check boxes:

– SMART Notebook 

– SMART Response 

– SMART Product Drivers 

– SMART Sync Teacher 

– SMART Sync Class List Server 

NOTE

SMART Sync Class List Server is server software that connects 

SMART Sync students and teachers.

– SMART Sync Administrator Tool 

NOTE

SMART Sync Administrator Tool is a program that enables you to create 

and edit SMART School files, which are central repositories of student, 

teacher, class, computer lab and computer information, as well as 

application and Internet blocking rules.

6. Select the Install Start menu and desktop shortcuts to install program 

shortcuts in the Start menu and on the desktop.
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To configure SPU 1. Click SMART Product Update (SPU) Options.

The SMART Product Update (SPU) Options page appears.

2. Select the Install SMART Product Update check box to install SPU.

3. In the Check for updates box, type the number of days between SPU checks.

NOTE

By default, SPU checks for product updates every 30 days. You can set SPU 

to check for product updates at intervals of 1 to 60 days.

4. Select the Notify users about SMART product updates check box to notify the 

teacher when product updates are available.

Configuring SMART Sync Teacher
If you chose to include SMART Sync Teacher in the installation (see page 36), 

configure the software by completing the procedure in this section.

To specify a

SMART School file

1. Click SMART School File.

The SMART School File page appears.

2. In the SMART School file box, type the path to the SMART School file.

OR

Click Browse and then use the resulting dialog box to browse to and select the 

SMART School file.

NOTE

Before you can specify the path to a SMART School file, you must install 

SMART Sync Administrator Tool (see page 36), and then use it to create the 

SMART School file (see page 70).

Configuring SMART Notebook software
If you chose to include SMART Notebook software in the installation (see page 36), 

configure the software by completing the procedures in this section.

To specify Gallery

collections and folders

For information on Gallery collections and folders, see page 51.
 



38 | CHAPTER 4  –  USING SMART INSTALL MANAGER
To specify

content folders

1. Click Team Content.

The Team Content page appears.

2. In the Team Content path box, type the path to the Team Content folder.

NOTES

– A Team Content folder is a location on your school’s network where 

teachers and students can store shared content.

– For information on creating a Team Content folder, see page 62.

3. Click My Content.

The My Content page appears.

4. In the My Content path box, type the path to the My Content folder.

NOTE

A My Content folder is a location on the teacher computer where the teacher 

can store individual content.

TIP

You can use environment variables in this path. This is useful if you want to 

store content on a shared network folder so users can access their My 

Content folder from any computer on your network.

To configure the

Optional Settings

1. Click Optional Settings.

The Optional Settings page appears.

2. Select the Install print capture driver check box to configure the Print Capture 

driver.

NOTE

The Print Capture driver is a printer driver that enables teachers to import 

content from other programs into SMART Notebook software.

3. Select the Install Notebook Plugin IE Helper Object checkbox to install the 

NotebookPlugin.dll file and add the associated registry keys.

IMPORTANT

If you have a security policy restricting the installation of any Internet Explorer 

ActiveX plug-ins (32-bit operating systems), you need to include this setting or 

the installation might not succeed.

NOTE

By default, this plug-in isn’t installed on 64-bit systems.
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4. Select the Install SMART Document Camera drivers check box to configure the 

SMART Document Camera driver.

NOTE

The SMART Document Camera driver option is checked by default.

To configure the

Customer Experience

Program

1. Click Customer Experience.

The Customer Experience page appears.

2. Click Allow users to participate in the Customer Experience Program to allow 

the teacher to enable or disable the Customer Experience Program.

OR

Click Enable the Customer Experience Program on all computers to enable 

the Customer Experience Program for the teacher automatically.

Configuring SMART Product Drivers
If you chose to include SMART Product Drivers in the installation (see page 36), 

configure the software by completing the procedure in this section.

To configure

SMART Product Drivers

1. Click SMART Board Driver Options.

The SMART Board Driver Options page appears.

2. Select the Start SMART Tools at logon check box to start SMART Tools when 

the teacher logs on.

3. Select the Enable Tablet PC Support check box to use Tablet PC functionality 

with the SMART Board interactive whiteboard without having to connect a 

Tablet PC.

NOTE

This check box is applicable only for the Windows Vista and Windows 7 

operating systems. It has no effect on other operating systems.

4. Select the Start Simple Network Management Protocol (SNMP) Agent 

check box to enable remote monitoring and control of your SMART products and 

projectors from a central location using SMART SNMP Agent.

NOTE

For more information on SMART SNMP Agent, see the SMART SNMP Agent 

Administrator’s Guide (smarttech.com/kb/150907).

5. Select the Start SMART Web Server at startup check box to start 

SMART Web Server when the teacher logs on.
 

http://www.smarttech.com/kb/150907


40 | CHAPTER 4  –  USING SMART INSTALL MANAGER
6. In the Port box, type a new port number for SMART Web Server if another 

program is using the default port (80).

Configuring SMART Response CE
If you chose to include SMART Response CE in the installation (see page 36), 

configure the software by completing the procedure in this section.

To configure

SMART Response CE

1. Click SMART Response Options.

The SMART Response Options page appears.

2. Select the Start Desktop Menu at log in for all users check box to add the 

SMART Response icon to the notification area when the teacher logs on.

Enabling the SMART Notebook Math Tools 30-day trial
SMART Notebook software includes a free 30-day trial of SMART Notebook Math 

Tools (see SMART Notebook Math Tools on page 3). You can enable or disable the 

trial software in SMART Install Manager.

To enable the SMART

Notebook Math Tools trial

1. Click SMART Notebook Math Tools.

The SMART Notebook Math Tools page appears.

2. Select the Install the free 30-day trial of SMART Notebook Math Tools 

check box.

Customizing the Student installation 
package
Open the SMART Classroom Student.msi file in SMART Install Manager 

(see page 34), and then complete the procedures in the following sections.

Setting general options
By completing the procedures in this section, you define which Student programs you 

want to include in the installation and set the following options:

• The folder for the Student programs

• The product key

• SPU preferences
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To set

installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for the 

SMART Classroom Suite Student programs.

NOTE

If you don’t specify a folder, Windows Installer installs the programs in 

%PROGRAMFILES%\SMART Technologies\Classroom Student.

3. In the Product key box, type your school’s 22-character product key for 

SMART Classroom Suite software.

4. Select the Activate SMART Classroom Suite during installation check box to 

activate SMART Classroom Suite software automatically during installation rather 

than manually after installation.

NOTE

To activate the suite automatically during installation, you must provide a 

product key.

5. Define which programs you want to include in the installation by selecting the 

appropriate check boxes:

– SMART Sync Student 

– SMART Notebook SE 

To configure SPU 1. Click SMART Product Update (SPU) Options.

The SMART Product Update (SPU) Options page appears.

2. Select the Install SMART Product Update check box to install SPU.

3. In the Check for updates box, type the number of days between SPU checks.

NOTE

By default, SPU checks for product updates every 30 days. You can set SPU 

to check for product updates at intervals of 1 to 60 days.

4. Select the Notify users about SMART product updates check box to notify the 

student when product updates are available.
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Configuring SMART Sync Student
If you chose to include SMART Sync Student in the installation, configure the software 

by completing the procedures in this section.

To include shortcuts 1. Click Shortcuts.

The Shortcuts page appears.

2. Select the Install Start menu and desktop shortcuts check box to include 

shortcuts to SMART Sync Student in the Start menu and on the desktop.

To specify

the configuration file

1. Click Configuration File.

The Configuration File page appears.

2. In the Configuration file box, type the path to the SyncClient.ini file.

OR

Click Browse, and then browse to and select the SyncClient.ini file.

NOTE

If you installed the SMART Sync Administrator Tool (see page 14), you can 

use the SMART Sync Student Configuration Tool to create a SyncClient.ini 

file, which you can then refer to in this box (see page 83).

Configuring SMART Notebook SE software
If you chose to include SMART Notebook SE software in the installation (see 

page 41), configure the software by completing the procedures in this section.

To configure Optional

Settings

1. Click Optional Settings.

The Optional Settings page appears.

2. Select the Install Notebook Plugin IE Helper Object check box to install the 

NotebookPlugin.dll file and add the associated registry keys.

IMPORTANT

If you have a security policy restricting the installation of any Internet Explorer 

ActiveX plug-ins (32-bit operating systems), you need to include this setting or 

the installation might not succeed.

NOTE

By default, this plug-in isn’t installed on 64-bit systems.
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To specify Gallery

collections and folders

For information on Gallery collections and folders, see page 47.

To specify

content folders

1. Click Team Content.

The Team Content page appears.

2. In the Team Content path box, type the path to the Team Content folder.

NOTES

– A Team Content folder is a location on your school’s network where 

teachers and students can store shared content.

– For information on creating a Team Content folder, see page 62.

3. Click My Content.

The My Content page appears.

4. In the My Content path box, type the path to the My Content folder.

NOTE

A My Content folder is a location on the student computer where the student 

can store individual content.

TIP

You can use environment variables in this path. This is useful if you want to 

store content on a shared network folder so users can access their My 

Content folder from any computer on your network.

To specify the

My Binder folder

1. Click My Binder Directory.

The My Binder Directory page appears.

2. Click Application Data to save the student’s Binder files in the Application Data 

folder.

OR

Click My Documents to save the student’s Binder files in the My Documents 

folder.

OR

Click Other to save the student’s Binder files in another folder, and then type the 

path to that folder in the box.
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To configure the

Customer Experience

Program

1. Click Customer Experience.

The Customer Experience page appears.

2. Click Allow users to participate in the Customer Experience Program to allow 

the student to enable or disable the Customer Experience Program.

OR

Click Enable the Customer Experience Program on all computers to enable 

the Customer Experience Program for the student automatically.

Deploying the installation packages
After you publish MST files for the Teacher and Student installation packages, you 

can install these installation packages using Group Policy-based software 

deployment.

NOTE

These procedures can vary depending on your version of Windows operating 

system and your system preferences.

To deploy an

installation package

1. Copy the MSI file and the .mst file you published using SMART Install Manager 

(see page 35) to \\[Domain Controller]\NETLOGON, where [Domain Controller] 

is your school’s domain controller.

2. Open Control Panel.

3. Double-click Administrative Tools.

4. Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

5. Right-click your school’s domain, and then select Properties.

The Properties dialog box appears.

6. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

7. Browse to and open Computer Configuration\Software Settings.

8. Right-click Software Installation, and then select New > Package.

9. Browse to and select the MSI file from step 1.

10. In the Deploy Software section, click Advanced, and then click OK.
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11. Click the Modifications tab, and then click Add.

12. Browse to and select the MST file from step 1.

13. Click OK to apply the MST file to the MSI file.

14. Close all open windows and dialog boxes.

The next time each computer on the domain starts, it automatically installs the 

software in Silent mode with the customizations defined in the MST file.

To remove a deployed

installation package

1. Open Control Panel.

2. Double-click Administrative Tools.

3. Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

4. Right-click your school’s domain, and then select Properties.

The Properties dialog box appears.

5. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

6. Browse to and open Computer Configuration\Software Settings\

Software Installation.

7. Right-click the software you want to remove, and then select All Tasks > 

Remove.

8. Select Immediately uninstall the software from users and computers, and 

then click OK.

The next time each computer on the domain starts, it automatically removes 

the software.
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Chapter 5

Installing and 
maintaining Gallery 
content
This chapter explains how to install and configure Gallery content using SMART 

Install Manager (page 48) or the command line interface (page 51), and how to modify 

it using Gallery Setup (page 54).

SMART Notebook software’s Gallery content includes the following:

• Gallery Essentials, which is a collection of educational photos and other images, 

audio files, and Adobe Flash Player compatible files

• Lesson Activity Toolkit, which contains objects you can use to create your own 

lesson activities

Gallery content is accessible from the Gallery tab in SMART Notebook software:
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Installing and configuring Gallery content 
using SMART Install Manager
You can install and configure Gallery content using SMART Install Manager. If you 

prefer to use the command line interface, see Installing and configuring Gallery 

content with the command line interface on page 51.

You can install and configure Gallery content in either of the following ways:

• On each computer (this page).

• In a network location you configure SMART Notebook software to refer to 

(page 51).

TIP

Sharing the Gallery is ideal for environments where hard disk space is limited. 

Installing Gallery content on each computer
Before you can install Gallery content on each computer, download it to a folder on 

your network.

IMPORTANT

If you download Gallery content to a folder on your network, ensure the folder is 

accessible to all users who need to access it. 

OR

Download the content from the SMART website to each computer during the 

installation.

NOTE

Because of the size of the Gallery download, SMART doesn’t recommend this 

method unless you’re installing the Gallery on only one or two computers.

To download

Gallery content

1. Open the Teacher or Student installation package in SMART Install Manager 

(see page 34).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Install the Gallery on each computer.

4. Delete the path in the Source location box, if a path appears.
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5. Click Download, and then specify a network folder accessible to all users who 

need to access the Gallery.

Gallery content is downloaded to the specified folder, where the installer will 

access it during the SMART Notebook software installation to place the content 

on each computer.

Configuring Gallery content on each computer
After you download Gallery content to a network folder, complete the procedure in this 

section to configure the installation to refer to the network location.

To configure

Gallery content on each

computer

1. Open the Teacher or Student installation package in SMART Install Manager 

(see page 34).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Install the Gallery on each computer.

4. In the Source location box, type the path of the folder on your network that 

contains the Gallery content (if you downloaded Gallery collections to your school 

network).

NOTE

The Source location box auto-populates with the path you specified in the 

Installing Gallery content on each computer procedure on page 48.

5. If you don’t want to use the default folder, type the path of the location on each 

computer where you want to install the Gallery collections in the Destination box.

NOTE

The default folder location is %ALLUSERSPROFILE%\Application 

Data\SMART Technologies.

6. Clear the check boxes of the Gallery collections you don’t want to install.

7. Publish your changes as an MST file (see page 35), and then deploy the MSI and 

MST files (see page 44).

The installed software accesses the Gallery content from the network location you 

specified in the previous procedure.
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Installing Gallery content in a network location
Downloading and installing Gallery content in a shared location on your school 

network gives all users access to it without having to save the files locally on their 

computers.

To place and use Gallery content in a shared location on your school network, you 

must first download and install the content in that location by performing the following 

procedure.

To download and install

Gallery content in a

network location

1. Open the Teacher or Student installation package in SMART Install Manager 

(see page 34).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Share Gallery content with all computers from a common network 

location.

4. If you want to download the Gallery Essentials collection, click Install beside 

Essentials for Educators, specify a network location accessible to all users, and 

then follow the on-screen instructions.

IMPORTANT

Use the UNC for the path in this and the following step.

NOTE

You can select which Gallery categories you want to install during the 

Gallery Setup. See Using Gallery Setup on page 54 for more information.

5. If you want to download the Lesson Activity Toolkit collection, click Install beside 

Lesson Activity Toolkit, specify a network location accessible to all users, and 

then follow the on-screen instructions.

Configuring Gallery content in a network location
After you download the Gallery content to a network folder, complete the following 

procedure to configure the installation to refer to the network location.

To configure

Gallery content using

SMART Install Manager

1. Open the Teacher or Student installation package in SMART Install Manager 

(see page 34).

2. Click Gallery Content.

The Gallery Content page appears.
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3. Click Share Gallery content with all computers from a common network 

location.

4. In the Gallery location box, type the path of the folder on your school network that 

contains the Gallery content.

NOTE

The Gallery location box auto-populates with the folder location you specified 

in Installing Gallery content in a network location on page 50.

5. Publish your changes as an MST file (see page 35), and then deploy the MSI and 

MST files (see page 44).

The installed software will access the Gallery content from the network location 

you specified in the previous procedure.

Installing and configuring Gallery content 
with the command line interface
You can install and configure Gallery content using the command line interface. If you 

prefer to use SMART Install Manager, see Installing and configuring Gallery content 

using SMART Install Manager on page 48.

You can install Gallery content in either of the following ways:

• On each computer (this page).

• In a network location you can configure SMART Notebook or SMART Notebook 

SE software to refer to (page 53). 

TIP

Sharing the Gallery is ideal for environments where hard disk space is limited. 

Installing Gallery content on each computer
Include the following properties in your command to install the Gallery on each 

computer. See Using the command line interface on page 9 for more information.

• CONTENT_SOURCE_PATH 

Value Enter this value to:

[Path] Specify the path to the folder on your school network that 

contains the Gallery Essentials and Lesson Activity Toolkit 

folders (if you downloaded the Gallery Essentials and 

Lesson Activity Toolkit collections).
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• CONTENT_TARGET_PATH

• FULL_GALLERY

• LAT_CONTENT 

• TEAM_CONTENT_PATH

IMPORTANT

You must specify a path to an existing folder in this property. See Changing 

Gallery content locations on page 60 for information on creating or changing the 

location of Team Content folders.

Value Enter this value to:

[Path] Specify the path to the folder where you want to install 

Gallery content (if you don’t want to use the default folder 

%ALLUSERSPROFILE%\Application Data\

SMART Technologies).

Value Enter this value to:

1 Install the full Gallery Essentials collection.

If you want to install certain categories only, include the 

following properties instead of FULL_GALLERY:

• ADMIN_CONTENT=1 (Administration and Evaluation)

• ARTS_CONTENT=1 (Arts)

• ENGLISH_CONTENT=1 (English and Language Arts)

• GEOGRAPHY_CONTENT=1 (Geography)

• HISTORY_CONTENT=1 (History)

• MATH_CONTENT=1 (Mathematics)

• PEOPLE_CONTENT=1 (People and Culture)

• SCIENCE_CONTENT=1 (Science and Technology)

• SPECIAL_CONTENT=1 (Special Needs)

• SPORTS_CONTENT=1 (Sports and Recreation)

Value Enter this value to:

1 Install the Lesson Activity Toolkit collection.

Value Enter this value to:

[Path] Specify the path to the folder where you want to save team 

content. My Documents is the default folder.
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• MY_CONTENT

TIP

You can use environment variables in this path. This is useful if you want to store 

content on a shared network folder so users can access their My Content folder 

from any computer on your network.

Configuring Gallery content in a network location
Include the following properties in your command to install the Gallery in a network 

location. See Using the command line interface on page 9 for more information.

IMPORTANT

You must refer to an existing folder to use these properties. See Using Gallery 

Setup on page 54 for more information.

• NETWORK_CONTENT 

NOTE

Because you include this property with a value of 1, Windows Installer ignores 

the CONTENT_SOURCE_PATH, FULL_GALLERY and *_CONTENT 

properties.

• CONTENT_TARGET_PATH 

Value Enter this value to:

[Path] Specify the path to the folder where you want the 

My Content folder to appear. My Documents is the default 

folder.

Value Enter this value to:

1 Refer to Gallery content in a shared location specified in the 

CONTENT_TARGET_PATH property.

Value Enter this value to:

[String] Specify the path to the folder on your school’s network that 

contains the Gallery Essentials and Lesson Activity Toolkit 

folders.
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Using Gallery Setup
After you install SMART Notebook or SMART Notebook SE software, you can modify 

Gallery content using Gallery Setup. This program is available under 

%PROGRAMFILES%\Common Files\SMART Technologies\

SMART Product Update, and you can run it from a graphical user interface or the 

command line.

To run Gallery Setup from

a graphical user interface

1. In Windows Explorer, browse to %PROGRAMFILES%\Common Files\

SMART Technologies\SMART Product Update.

2. Double-click Gallery Setup.exe.

The Select a Gallery dialog box appears.

3. Select the Gallery collection you want to modify, and then click OK.

Gallery Setup starts.

4. On the Content tab, select the check boxes of the categories you want to include 

and clear the check boxes of the categories you don’t want to include.

5. On the Languages tab, select the check boxes of the language packs you want to 

include and clear the check boxes of the language packs you don’t want 

to include.

TIP

To see the language pack names in English, clear the Show native names 

check box.

6. In the Installation folder for Gallery content box, type the path to the folder where 

you want to store the Gallery collection.

7. Click OK.

Gallery Setup updates the selected Gallery collection.

8. Click Finish.
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To run Gallery Setup from

the command line

1. Open the Command Prompt window.

2. Type the following command:

"[Path]\Gallery Setup.exe" [Command] [Flags] [Parameters] 

Where:

– [Path] is the path to the Gallery Setup.exe file.

NOTE

The default path is %PROGRAMFILES%\Common Files\

SMART Technologies\SMART Product Update.

– [Command] is a command (see page 56).

– [Flags] is one or more optional flags for the command (see page 57).

– [Parameters] is one or more parameters for the command (see page 58).

NOTES

– For example commands, see page 59.

– Gallery Setup doesn’t support Windows Installer options.

3. Press ENTER.

Gallery Setup updates the selected Gallery collection.
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Commands
The following table defines available commands for Gallery Setup.

Command Purpose Notes

--downloadall Downloads the entire Gallery 

collection to a source folder.

--downloadsome Downloads specific categories 

of the Gallery collection to a 

source folder.

Specify which categories you 

want to download using the --c 

parameter.

--installall Installs the entire Gallery 

collection from the source 

folder to the destination folder.

• If you omit the --source 

parameter, Gallery Setup 

doesn’t use a default path 

unless you provide the 

--allowdownload flag.

• If you omit the --destination 

parameter, Gallery Setup 

uses the default path 

defined in the Gallery 

collection’s configuration.

--installsome Installs specific categories of 

the Gallery collection from the 

source folder to the destination 

folder.

• If you omit the --source 

parameter, Gallery Setup 

doesn’t use a default path 

unless you provide the 

--allowdownload flag.

• If you omit the --destination 

parameter, Gallery Setup 

uses the default path 

defined in the Gallery 

collection’s configuration.

• Specify which categories 

you want to download using 

the --c parameter.

--teamcontent Registers additional Team 

Content at the the folder 

specified by the --destination 

parameter.

You must enter an existing 

Gallery destination.

--mycontent Sets the default My Content 

path to the folder specified by 

the --destination parameter.
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Flags
The following table defines available flags for Gallery Setup.

--repair Attempts to detect and 

optionally remove corrupted 

galleries. 

Include the --allowcleanup 

parameter to delete corrupt 

galleries.

--uninstall Removes the installed Gallery 

collection.

--register Defines the location of Gallery 

content.

Use this command with the 

--destination and 

--configuration parameters, or 

with the --guid parameter.

Flag Purpose Notes

--remote Prevents Gallery Setup from 

registering itself with 

SMART Notebook software.

This disables the Check for 

Updates feature and prevents 

users from updating Gallery 

content.

--verbose Outputs progress of operations 

to standard output when 

working in command line 

mode.

--overrideproxy Sets Gallery Setup to ignore 

default (system-wide or 

previously set) proxy settings 

where applicable, and uses a 

proxy specified by the --proxy 

parameter (server:port 

format), using a user name and 

password provided by the 

--username and --password 

parameters.

You can set a user name and 

password without 

--overrideproxy and still use it 

for authentication with the 

default proxy.

--allowdownload Downloads the Gallery 

collection from the default URL 

specified in the configuration.

Use this flag with the 

--installall or --installsome 

parameters when you omit the 

--source parameter.

--forcedest Shares Gallery content with all 

users.

Command Purpose Notes
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Parameters
The following table defines available parameters for Gallery Setup.

Parameter Value Purpose Notes

--source [Path] Defines the path to a local or 

network folder where Gallery 

content is stored before 

installation.

If you omit this parameter, the 

installation program uses the 

default URL from the Gallery 

configuration, as specified by 

the --guid or --configuration 

parameter.

--destination [Path] Defines the path to a local or 

network folder where Gallery 

Setup installs the Gallery 

content.

If you omit this parameter, 

Gallery Setup uses this default 

path found in the computer’s 

registry: 

%ALLUSERPROFILES%\

Application Data\

SMART Technologies\

Gallery Essentials.

--configuration [Path] Defines the full path to a 

.gallerycollection file, including 

the file name.

If you omit this parameter, you 

must provide the --guid 

parameter to specify a known 

Gallery collection.

--proxy [Server:

Port]

Specifies the proxy used by 

Gallery Setup when you 

include the --overrideproxy 

flag.

--guid [Identifier] Specifies a known Gallery 

collection to work with.

A Gallery collection is known if 

Gallery Setup has already 

opened its .gallerycollection 

file. In this situation, use this 

parameter instead of the 

--configuration parameter.
 



59 | CHAPTER 5  –  INSTALLING AND MAINTAINING GALLERY CONTENT
Examples

Downloading a Gallery collection

Use the following command to download Gallery collection source files to a 

destination folder:

"[Path]\Gallery Setup.exe" --downloadall --destination 
"[Path]" --configuration "[Path]"

--c [Alias] Downloads or installs the 

category of the Gallery 

collection identified by [Alias].

Use this parameter with the 

--downloadsome and 

--installsome commands.

You can include several --c 

parameters in a single 

command. Valid [Alias] values 

for the Gallery Essentials 

collection are:

• administration

• arts

• english

• geography

• history

• math

• people

• tech

• needs

• sports

--ui N/A Specifies the user interface 

level.

Use this parameter to show a 

progress indicator and error 

messages. If you don’t include 

this parameter, Gallery Setup 

works silently without a user 

interface.

• Use --register with the 

--downloadall or 

--downloadsome 

parameter to display the full 

user interface.

• Use --register with the 

--installall or --installsome 

parameter to display a 

minimal user interface.

Parameter Value Purpose Notes
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Downloading certain categories of a Gallery collection

Use the following command to download only certain categories of Gallery collection 

source files to a destination folder:

"[Path]\Gallery Setup.exe" --downloadsome --destination 
"[Path]" --configuration "[Path]" --c "[Alias 1]" 
--c "[Alias 2]"

Installing a Gallery collection

Use the following command to download and install a Gallery collection to a 

destination folder:

"[Path]\Gallery Setup.exe" --installall --allowdownload 
--destination "[Path]" --configuration "[Path]"

Installing certain categories of a Gallery collection

Use the following command to download and install certain categories of a Gallery 

collection to a specific destination folder:

"[Path]\Gallery Setup.exe" --installsome --remote 
--source "[Path]" --allowdownload --destination "[Path]" 
--configuration "[Path]" --c "[Alias 1]" --c "[Alias 2]"

Registering installed Gallery collections with SMART Notebook software

If you installed Gallery collections to a network location, use the following command to 

register the Gallery content with SMART Notebook software on each user’s computer:

"[Path]\Gallery Setup.exe" --register --remote --forcedest 
--destination "[Path]" --configuration "[Path]"

Removing a Gallery collection

Use the following command to remove the Gallery Essentials collection:

"[Path]\Gallery Setup.exe" --uninstall 
--guid gallery.smarttech.com

TIP

To automate the removal of a Gallery collection, you can use the command in a 

batch file as a startup script.

Changing Gallery content locations
After you install the suite, you can do the following:

• Change the location of the My Content folder

• Create or connect to a Team Content folder
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• Connect to an RSS feed

Starting SMART Notebook or SMART Notebook SE software 
in Administration mode
Before you can maintain content folders in SMART Notebook or SMART Notebook SE 

software, you must start the programs in Administration mode.

To start

SMART Notebook

software in

Administration mode

1. Open the Command Prompt window.

2. Type "[Path]\Notebook.exe" /admin, where [Path] is the path to the 

SMART Notebook program folder, and then press ENTER.

NOTE

The default path is %PROGRAMFILES%\SMART Technologies\

Classroom Teacher.

SMART Notebook software starts in Administration mode.

To start

SMART Notebook SE

software in

Administration mode

1. Open the Command Prompt window.

2. Type "[Path]\SMARTNotebookSE.exe" /admin, where [Path] is the path to the 

SMART Notebook SE program folder, and then press ENTER.

NOTE

The default path is %PROGRAMFILES%\SMART Technologies\

Classroom Student.

SMART Notebook SE software starts in Administration mode.

Changing the location of the My Content folder
The My Content folder is a location where teachers and students can store content for 

their individual use.

You can specify the location of the My Content folder during installation. If you don’t 

specify a location, the default location is %APPDATA%\SMART Technologies\

Gallery\My Content.

You can change the location of the My Content folder after installation.

To change the

location of the

My Content folder

1. Start SMART Notebook or SMART Notebook SE software in Administration mode 

(see page 61).

2. Open the Gallery tab.
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3. Click Show additional Gallery actions , and then select 

Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Browse.

The Browse For Folder dialog box appears.

5. Browse to and select the new My Content folder, and then click OK.

6. Click Close.

7. Close SMART Notebook or SMART Notebook SE software.

Creating or connecting to Team Content folders
All SMART Notebook and SMART Notebook SE software users can create new 

content and save it in their My Content folders. To allow users to share content, you 

must create or connect to a Team Content folder.

TIP

If you create a Team Content folder on a computer’s hard disk, the folder is 

available only to users of that computer. However, if you create a Team Content 

folder on a server, the folder is available to all users on the school’s network with 

read and write access to that folder.

To create a

Team Content folder

1. Start SMART Notebook or SMART Notebook SE software in Administration mode 

(see page 61).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 

Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Create New.

The Browse For Folder dialog box appears.

5. Browse to and select the folder you want to designate as a Team Content folder, 

and then click OK.

NOTE

SMART Notebook software adds a imsmanifest.xml file to the Team Content 

folder after you click OK. This file identifies the folder as a Team Content 

folder.
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6. Click Close.

7. Close SMART Notebook or SMART Notebook SE software.

To connect to an existing

Team Content folder

1. Start SMART Notebook or SMART Notebook SE software in Administration mode 

(see page 61).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 

Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Add Existing.

The Browse For Folder dialog box appears.

5. Browse to and select the Team Content folder, and then click OK.

6. Click Close.

7. Close SMART Notebook or SMART Notebook SE software .

To disconnect a

Team Content folder

1. Start SMART Notebook software or SMART Notebook SE in Administration mode 

(see page 61).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 

Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Select the folder in the Team Content list, and then click Remove.

IMPORTANT

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, 

folders for those collections appear in the Team Content list. Do not remove 

these folders from the list, or users will not be able to access these 

collections.

5. Click Close.

6. Close SMART Notebook or SMART Notebook SE software.

Connecting to an RSS feed
RSS is a format for delivering regularly changing web content. Many news-related 

websites, blogs and other publishers broadcast their content as RSS feeds.
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You can connect to a public or private RSS feed to send information to your school’s 

SMART Notebook software and SMART Notebook SE users through the Gallery tab.

To connect to an RSS feed 1. Start SMART Notebook software or SMART Notebook SE in Administration mode 

(see page 61).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 

Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Type the URL of the RSS feed in the Online Resources box.

5. Click Close.

6. Close SMART Notebook software or SMART Notebook SE.
 



Chapter 6

Configuring 
SMART Response CE

This chapter explains how to set the encryption method and service ports for SMART 

Response CE and how to switch between SMART Response modes.

Setting the encryption method and 
service ports
By default, SMART Response CE uses Diffie-Hellman to encrypt information between 

teachers and students. In addition, it uses a randomized port for the encrypted data 

channel and port 23457 for the file data channel. You can change these default 

settings if you prefer to use SSL for encryption or different ports for the encrypted and 

file data channels.

NOTE

Use the Diffie-Hellman key exchange encryption method if you don’t want to 

provide third-party programs access to SMART Response CE. Otherwise, use the 

SSL digital certificate encryption method.

To set the

encryption method

1. On the teacher’s computer, start Teacher Tools, and then open Gradebook view.

2. Select Edit > Preferences.

The SMART Response Preferences dialog box appears.

3. Click the Encryption tab.

4. Select Diffie Hellman in the Method drop-down list to use the Diffie-Hellman 

key exchange encryption method, and then proceed to step 6.

OR

Select SSL Digital Certificate in the Method drop-down list to use the SSL digital 

certificate encryption method, and then proceed to step 5.
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5. Click Automatically generated certificate to use an automatically generated 

SSL digital certificate.

OR

Click Imported certificate to use an imported SSL digital certificate, and then 

browse to and select one PEM file or two DER files (one for the certificate and one 

for the private key) in the Import certificate file dialog box.

6. Click OK.

To specify an

SSL digital certificate

1. Generate a PEM file, using the computer’s host name as the file name 

(for example, columbushighsrvr1.pem).

TIPS

– Create the PEM file using OpenSSL or a similar tool.

– To determine the computer’s host name, open the Command Prompt 

window, type ipconfig /all, and then press ENTER.

2. Open Microsoft® Registry Editor.

3. Browse to and open HKEY_LOCAL_MACHINE\SOFTWARE\

SMART Technologies\Response\SoftwareService.

4. Select Edit > New > String Value.

Microsoft Registry Editor adds a new string value to the Software Service key.

5. Change the new string value’s name to CertificateFolder and its value data to 

the folder where you stored the PEM file.

6. Close Microsoft Registry Editor.

To set the service ports 1. On the teacher’s computer, start Teacher Tools, and then open Gradebook view.

2. Select Edit > Preferences.

The SMART Response Preferences dialog box appears.

3. Click the Networking tab.

4. Type the port number for the encrypted data channel in the Encrypted data 

channel box.

OR

Select the Randomize check box to use a random port number for the encrypted 

data channel.
 

http://www.openssl.org/
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5. Type the port number for the file data channel in the File data channel box.

OR

Select the Randomize check box to use a random port number for the file 

data channel.

6. Click OK.

Switching SMART Response modes
SMART Classroom Suite supports seven SMART Response software modes:

NOTE

For detailed information on the differences between SMART Response and 

SMART Response CE modes, see the SMART Response and 

SMART Response CE Assessment Software Comparison (smarttech.com/kb/

138076).

When you install SMART Classroom Suite, the software starts SMART Response CE 

mode by default. However, you can switch the software to another mode if your school 

has SMART Response hardware and you want to use it for assessments.

NOTES

• You must have administrative privileges on your computer to use the 

SMART Response Setup Tool. 

• Different question types may be available to different student devices.

Mode Student input Connection

SMART Response SMART Response clickers SMART Response receiver

SMART Response LE SMART Response LE 

clickers

SMART Response receiver

SMART Response PE SMART Response PE 

clickers

SMART Response receiver

SMART Response CE SMART Notebook SE School network

SMART Response XE SMART Response XE 

clickers

SMART Response receiver

SMART Response VE 

(Beta)

Internet enabled devices Internet enabled devices

Any SMART Response 

clicker

Any SMART Response 

clicker

SMART Response receiver
 

http://www2.smarttech.com/kbdoc/138076
http://www2.smarttech.com/kbdoc/138076
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• You don’t need administrative privileges on your computer to switch modes.

• Before switching modes, stop any running classes, and close SMART 

Notebook software and Teacher Tools if they’re running.

To switch modes 1. Select Start > All Programs > SMART Technologies > SMART Response > 

Setup Tool.

The SMART Response Setup Tool dialog box appears.

2. Select a different mode, and then click OK.

A message appears.

3. Click OK.

4. Follow the instructions in the SMART Response User’s Guide to set up the 

hardware.
 



Chapter 7

Configuring 
SMART Sync
This chapter explains how to configure the SMART Sync components of 

SMART Classroom Suite.

From an administrator’s perspective, SMART Sync consists of four components:

• SMART Sync Teacher: A program that resides on teacher computers and 

enables them to connect with students and teacher aides

• SMART Sync Student: A program that resides on student computers and 

enables them to connect with teachers

• SMART Sync Class List Server: Server software that connects students 

and teachers

• SMART Sync Administrator Tool: A program that enables you to create and edit 

SMART School files, which are central repositories of student, teacher, class, 

computer lab and computer information, as well as application and Internet 

blocking rules

NOTE

SMART Sync Class List Server and SMART Sync Administrator Tool are optional. 

You don’t need to install them to use SMART Sync Teacher and SMART Sync 

Student. However, there are benefits to installing them, which are explained in the 

remainder of this chapter.
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Setting up SMART School files
SMART Sync Administrator Tool enables you to create and update SMART School 

(.school) files.

A SMART School file contains information about students, teachers, classes and 

computer labs in your school as well as rules that teachers can apply to block student 

access to applications and websites. If you specify the location of a SMART School 

file in SMART Sync Teacher, teachers can use this information to connect to 

their students.

In most situations, you need to create only one SMART School file per school so that 

all teachers and students in the school can connect to each other. For security 

reasons, when you create the file, save it in a location accessible to teachers and 

network administrators, but not to students. After you create the file, you can update it 

at any time.

Creating or opening a SMART School file
The first step in setting up a SMART School file is to create or open the file using 

SMART Sync Administrator Tool.

To create a

SMART School file

1. On the teacher or administrator computer, double-click the SMART Sync 

Administrator Tool 2010 icon on your desktop.

2. Click School File.

3. Click Create a new SMART School file and save it as.

4. Click Browse.

The Select School File Location dialog box appears.

5. Browse to the folder where you want to create the SMART School file.

IMPORTANT

For security reasons, create the SMART School file in a folder accessible to 

teachers and network administrators, but not to students.

6. Type a name for the SMART School file in the File name box.

7. Click Save.

The Select School File Location dialog box closes, and the path to the 

SMART School file appears in the box below the Create a new SMART School file 

and save it as option.
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To open a

SMART School file

1. On the teacher or administrator computer, double-click the SMART Sync 

Administrator Tool 2010 icon on your desktop.

2. Click School File.

3. Click Edit the existing SMART School file in this location.

4. Click Browse.

The Open School File dialog box appears.

5. Browse to and select the SMART School file.

6. Click Open.

The Open School File dialog box closes, and the path to the SMART School file 

appears in the box below the Edit the existing SMART School file in this location 

option.

Locating SMART Sync Class List Server
You must enter the host name or IP address of the computer hosting SMART Sync 

Class List Server in your SMART School files.

To locate SMART Sync

Class List Server

1. Ensure SMART Sync Class List Server is running (see page 87).

2. Create or open a SMART School file (see page 70).

3. Click Class List Server.

4. Type the host name or IP address of the computer hosting SMART Sync Class 

List Server in the Enter the IP address or hostname of your Class List Server box.

NOTES

– SMART Sync Class List Server uses port number 46200 by default. 

However, you can change the port number (see page 89). If you do so, 

you must include the port number after the host name or IP address 

(for example, 127.0.0.1:46201).

– If your network uses Dynamic Host Configuration Protocol (DHCP), refer 

to the SMART Sync Class List Server computer by host name rather than 

by IP address.

5. Click Test Connection to test the connection to the SMART Sync Class List 

Server computer.
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Importing school information
You can manually enter students, teachers, classes and computer labs in SMART 

School files using SMART Sync Administrator Tool. Alternatively, you can import this 

information from comma separated value (CSV) files.

To create the student,

teacher and class CSV file

1. Using Excel® or another program that generates CSV files, create a spreadsheet 

with seven columns:

Column name Req’d? Type Description

Person ID Yes String The student’s or the teacher’s unique 

ID.

NOTE

The ID must be unique to the 

student or teacher. For example, 

a student and a teacher can’t 

both have the ID 123456.

Last Name Yes String The student’s or the teacher’s last 

name.

First Name Yes String The student’s or the teacher’s first 

name.

Title No String The student’s or the teacher’s title 

(for example, Mr., Ms. or Dr.).

NOTE

SMART Sync Administrator Tool 

stores this information for 

teachers only.

Class ID No String The unique ID of the student’s or the 

teacher’s class.

Class Title No String The name of the student’s or the 

teacher’s class.

If appropriate, include the class’s 

period to distinguish it from other 

classes.

Type Yes Integer

(0 or 1)

0 for a student.

OR

1 for a teacher.
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NOTES

– The first row of the spreadsheet must contain the column names as listed 

in the previous table.

– The string columns can contain any character except commas (,).

The following is an example:

2. Save the spreadsheet as a CSV file.

NOTE

See the program’s Help for instructions on saving spreadsheets as CSV files.

To create the

computer lab CSV file

1. Using Excel or another program that generates CSV files, create a spreadsheet 

with four columns:

Column name Req’d? Type Description

Hostname Yes String The computer’s host name or IP 

address (for example, 127.0.0.1).

NOTE

If your network uses DHCP, refer 

to the computer by host name 

rather than by IP address.

Workstation 

Name

No String The computer’s name.

Lab ID Yes String The unique ID of the computer’s lab.

Lab Title Yes String The name of the computer’s lab.
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NOTES

– The first row of the spreadsheet must contain the column names as listed 

in the previous table.

– The string columns can contain any character except commas (,).

The following is an example:

2. Save the spreadsheet as a CSV file.

NOTE

See the program’s Help for instructions on saving spreadsheets as CSV files.

To import the CSV files 1. Create or open a SMART School file (page 70).

2. Click Import Information.

3. Click Browse to the right of the Student, Teacher, Class CSV File Location box.

The Open Classes CSV File dialog box appears.

4. Browse to and select the CSV file.

5. Click Open.

The Open Classes CSV File dialog box closes, and the path to the CSV file 

appears in the Student, Teacher, Class CSV File Location box.

6. Click Browse to the right of the Computer, Lab CSV File Location box.

The Open Labs CSV File dialog box appears.
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7. Browse to and select the CSV file.

8. Click Open.

The Open Labs CSV File dialog box closes, and the path to the CSV file appears 

in the Computer, Lab CSV File Location box.

Entering student, teacher and class information
You can import student, teacher, and class information from a CSV file (page 72). 

Alternatively, you can manually enter student, teacher and class information in a 

SMART School file using SMART Sync Administrator Tool.

Entering student information

To add a student 1. Create or open a SMART School file (see page 70).

2. Click Students.

3. Click Add Student.

A new row appears in the table.

4. Type the student’s last name in the Last Name column.

5. Type the student’s first name in the First Name column.

6. Type the student’s ID in the Student ID column.

NOTE

SMART Sync Administrator Tool generates a random ID for the student if you 

don’t specify one.

To remove a student 1. Open a SMART School file (see page 70).

2. Click Students.

3. Select the student’s row in the table.

4. Click Remove Student.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.
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Entering teacher information

To add a teacher 1. Create or open a SMART School file (see page 70).

2. Click Teachers.

3. Click Add Teacher.

A new row appears in the table.

4. Type the teacher’s last name in the Last Name column.

5. Type the teacher’s first name in the First Name column.

6. Type the teacher’s title in the Title column (for example, Mr., Ms. or Dr.).

To remove a teacher 1. Open a SMART School file (see page 70).

2. Click Teachers.

3. Select the teacher’s row in the table.

4. Click Remove Teacher.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.

Entering class information

To add a class 1. Create or open a SMART School file (see page 70).

2. Click Classes.

3. Click Add.

A new row appears in the table.

4. Type a name for the class in the Class Name column (for example, 

5th Grade Math).

If appropriate, include the class’s period to distinguish it from other classes.
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5. Select the name of a teacher or student you want to include in the class in the 

All Students and Teachers list, and then click  to move it to the Class Members 

list.

NOTES

– In the All Students and Teachers and Class Members lists, teachers’ 

names appear in red text and students’ names appear in black text.

– To remove teachers or students from a class, select their names in the 

Class Members list, and then click  to move them to the All Students 

and Teachers list.

6. Repeat step 5 for each teacher or student you want to add to the class.

To remove a class 1. Open a SMART School file (see page 70).

2. Click Classes.

3. Select the class’s row in the table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.

Entering computer lab information
You can import computer lab information from a CSV file (see page 72). Alternatively, 

you can manually enter computer lab information in a SMART School file using the 

Computer Labs page of SMART Sync Administrator Tool.

To add a computer lab 1. Create or open a SMART School file (see page 70).

2. Click Computer Labs.

3. Click Add.

A new row appears in the computer lab table.

4. Type a name for the computer lab in the Lab Name column (for example, 

Main Lab).
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5. Click Add Computer.

A new row appears in the computer table.

6. Type the host name or IP address of the computer in the Hostname column (for 

example, 127.0.0.1).

NOTE

If your network uses DHCP, refer to the computer by host name rather than by 

IP address.

7. Type the name of the computer in the Workstation Name column (for example, 

Main Lab WS1).

8. Repeat steps 5 to 7 for each computer you want to add to the computer lab.

NOTE

To remove a computer from the computer lab, select the computer, and then 

click Remove Computer.

To remove a computer lab 1. Open a SMART School file (see page 70).

2. Click Computer Labs.

3. Select the computer lab’s row in the computer lab table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.
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Entering application blocking rules
An application blocking rule allows teachers either to allow specific applications and 

block all others or to block specific applications and allow all others. For example, an 

English teacher could allow access to Microsoft Word, but block access to all other 

applications during the writing of an English paper.

To add an application

blocking rule

1. Create or open a SMART School file (see page 70).

2. Click Application Blocking.

3. Click Add.

A new row appears in the application blocking rule table.

4. Type a name for the rule in the Rule Name column (for example, English Paper).

5. Click Block all applications except those listed below if you want to block all 

applications except those you specify.

OR

Click Allow all applications except those listed below if you want to allow all 

applications except those you specify.

6. Click Add Application.

The Select Application dialog box appears.

7. Browse to and select the application’s executable (.exe) file.

TIP

Most executable files are located in C:\Program Files.

8. Click Open.

The Select Application dialog box closes, and a new row appears in the 

application table.

9. Type a name for the application in the Display Name column if you don’t want to 

use the default name.

10. Repeat steps 6 to 9 for each application you want to add to the application 

blocking rule.

NOTE

To remove an application from the application blocking rule, select the 

application, and then click Remove Application.
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To remove an application

blocking rule

1. Open a SMART School file (see page 70).

2. Click Application Blocking.

3. Select the application blocking rule’s row in the application blocking rule table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.

Entering Internet blocking rules
An Internet blocking rule allows teachers either to allow specific websites and block all 

others or to block specific websites and allow all others. For example, a history 

teacher could block access to Wikipedia® during the writing of a history paper.

To add an Internet

blocking rule

1. Create or open a SMART School file (see page 70).

2. Click Internet Blocking.

3. Click Add.

A new row appears in the Internet blocking rule table.

4. Type a name for the rule in the Rule Name column (for example, History Paper).

5. Click Block all websites except those listed below if you want to block all 

websites except those you specify.

OR

Click Allow all websites except those listed below if you want to allow all 

websites except those you specify.

6. Click Add Website.

A new row appears in the website table.
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7. Type the address of the website in the Website Address column (for example, 

www.wikipedia.org).

8. Repeat steps 6 to 7 for each website that you want to add to the Internet 

blocking rule.

NOTE

To remove a website from the Internet blocking rule, select the website, and 

then click Remove Website.

To remove an

Internet blocking rule

1. Open a SMART School file (see page 70).

2. Click Internet Blocking.

3. Select the Internet blocking rule’s row in the Internet blocking rule table.

4. Click Remove.

The Confirm Deletion dialog box appears.

5. Click Yes.

TIP

Select the Don’t warn me again this session check box to prevent the 

Confirm Deletion dialog box from appearing for the remainder of the session.

Reviewing the SMART School file
After you set up a SMART School file, you can review it in the Summary page and 

then close SMART Sync Administrator Tool to save the file. You should complete the 

following tasks before reviewing and saving the file:

• Locate SMART Sync Class List Server (see page 71)

• Import school information (see page 72)

OR

Enter student, class and teacher information (see page 75) and computer lab 

information (see page 77)

• Enter application blocking rules (see page 79)

• Enter Internet blocking rules (see page 80)
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To review the

SMART School file

1. Open a SMART School file (see page 70).

2. Click Summary.

If any warnings appear, read them and take the appropriate actions.

3. Click Exit.

Specifying the location of the SMART School file
When you install SMART Classroom Suite software, you can specify the location of 

the SMART School file. If you don’t specify the location of the SMART School file 

during installation or need to change it later, you can do so in SMART Sync Teacher.

To specify the location of

the SMART School file

1. On the teacher’s computer, start SMART Sync Teacher.

2. Select Options > Preferences.

The Preferences dialog box appears.

3. On the General tab, click Browse.

The Open dialog box appears.

4. Browse to and select the SMART School file.

5. Click Open.

The Open dialog box closes, and the path to the SMART School file appears in 

the School File Location box.

6. Click OK, and then close SMART Sync Teacher.

The next time the teacher starts SMART Sync Teacher, the Welcome to 

SMART Sync – Teacher and Class Selection dialog box includes teachers and 

classes from the SMART School file.

NOTE

(Administered) appears beside classes from the SMART School file in the 

Welcome to SMART Sync – Teacher and Class Selection dialog box.
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Configuring SMART Sync Student
If you previously installed and configured SMART Sync Student on a student’s 

computer, Windows Installer uses that installation’s SyncClient.ini file to configure 

SMART Sync Student. Otherwise, Windows Installer uses a default SyncClient.ini 

file. In either case, you can reconfigure SMART Sync Student using the SMART Sync 

Student Configuration Tool.

Running the SMART Sync Student Configuration Tool
If you want to configure your school’s SMART Sync Student installations, you can 

manually run the SMART Sync Student Configuration Tool.

To run the

SMART Sync Student

Configuration Tool

1. On the teacher computer, browse to %PROGRAMFILES%\

SMART Technologies\Classroom Teacher\Sync Teacher\StudentConfig.exe.

The SMART Sync Student Configuration Tool window appears.

2. Click Next, and then click one of the following options:

NOTE

If you click Hidden from students, the student is unable to do the following:

– Connect to a teacher by selecting his or her name from a list

– Manually start SMART Sync Student

– Manually enter an ID after starting SMART Sync Student

The relevant controls in SMART Sync Student Configuration Tool are disabled or 

hidden.

3. Click one of the following options:

Option Click this option to:

Visible to students Show the SMART Sync user interface to 

the student.

Hidden from students Hide the SMART Sync user interface from 

the student.

Option Click this option to:

Allows the student to 

select from a list of 

available teachers

Allow the student to select a teacher from a list.

NOTE

This option is disabled if you clicked 

Hidden from student in step 2.
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4. If the computer has multiple network adapters, click Network Adapter Selection 

to specify the order of the network adapters, and then click Next.

5. Clear the Start SMART Sync automatically check box if you don’t want SMART 

Sync Student to start when the student first logs on.

NOTE

This check box is disabled if you selected Hidden from student in step 2.

6. Select the student’s language in the Language drop-down list.

Automatically connects 

with this Teacher ID

Connect SMART Sync to a specific teacher through 

the teacher’s ID.

Type the ID in the box to the right of the option.

Automatically connects 

with this hostname or 

IP address

Connect SMART Sync to a specific teacher through 

the host name or IP address.

Type the host name or IP address in the box to the 

right of that option.

NOTE

If your network uses DHCP, refer to the 

computer by host name rather than by 

IP address.

Uses this Class List 

Server hostname or IP 

address

Connect SMART Sync to a specific teacher using 

SMART Sync Class List Server.

Type the host name or IP address of the SMART 

Sync Class List Server computer in the box to the 

right of the option.

NOTE

If your network uses DHCP, refer to the SMART 

Sync Class List Server computer by host name 

rather than by IP address.

Option Click this option to:
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7. Select any of the following check boxes, and then click Next:

NOTE

These check boxes aren’t visible if you selected Hidden from student in 

step 2.

8. Click one of the following options, and then click Next:

Check box Select this check box to:

Ask questions Allow the student to ask questions through 

SMART Sync.

Chat Allow the student to chat with other students 

through SMART Sync.

Submit files Allow the student to submit files through 

SMART Sync.

Exit the Student program Allow the student to close SMART Sync Student.

Option Click this option to:

Student Controlled Allow the student to enter an ID when SMART Sync 

Student starts.

NOTE

This option is disabled if you selected 

Hidden from student in step 2.

The following Enter a specific student ID.

Type the ID in the box to the right of this option.

Found in this 

Active Directory field

Find the student ID in an Active Directory directory 

service field of the student’s login account.

Type the Active Directory directory service field 

name in the box to the right of this option.

Anonymous Allow the student to use SMART Sync Student 

without entering an ID.
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9. Click one of the following options, and then click Next:

10. Click one of the following options, and then click Next:

11. Click Finish.

The Restart Required to Apply Settings message appears.

12. Click OK.

Automatically configuring SMART Sync Student installations
After you create a SyncClient.ini file with the SMART Sync Student Configuration 

Tool, copy the file to a central location on your network. (The SyncClient.ini file is 

located in %PROGRAMFILES%\SMART Technologies\Classroom Teacher\

Sync Teacher.) You can then:

• Copy the file to existing SMART Sync Student installations to configure them

• Refer to the file when installing the suite using the command line interface 

(see page 9) or SMART Install Manager (see page 33)

Option Click this option to:

My Documents folder Store files the teacher shares with the student in the 

My Documents folder.

Custom folder Store files in another folder.

Type the path to the folder in the box below 

this option.

Option Click this option to:

No security Allow any teacher with SMART Sync Teacher to 

connect to the student.

Allow only teachers with 

this class password

Allow only teachers who enter a specified password 

in SMART Sync Teacher to connect to the student.

Type the password in the two boxes to the right of 

this option.

Allow only teachers who 

are part of the following 

group(s)

Allow only teachers in certain groups to connect to 

the student.

Select the groups in the box below this option.
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Configuring SMART Sync Class List Server
SMART Sync Class List Server is a Windows service that connects SMART Sync 

Teacher and SMART Sync Student installations in your school.

In most situations, you don’t need to make any changes to SMART Sync Class List 

Server after installation. However, in some situations, you may need to do the 

following:

• Stop and start SMART Sync Class List Server

• Change the SMART Sync Class List Server port number

NOTE

These procedures vary depending on your version of Windows operating system 

and your system preferences.

Stopping and starting SMART Sync Class List Server
SMART Sync Class List Server starts automatically after you install it and each time 

you turn on the computer. You can manually stop and then start SMART Sync Class 

List Server if necessary.

Stopping SMART Sync Class List Server

To stop

Class List Server

from the Command

Prompt

1. Open the Command Prompt window.

2. Browse to the folder containing the SMART Sync Class List Server executable 

file.

NOTE

In most installations, this folder is %PROGRAMFILES%\

SMART Technologies\Classroom Teacher\Sync Teacher.

3. Type the following command:

SMARTSyncClassListServer.exe -stop

4. Press ENTER.

SMART Sync Class List Server stops.
 



88 | CHAPTER 7  –  CONFIGURING SMART SYNC
To stop

Class List Server

from the Services window

1. Open Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window appears.

4. Scroll to and select SMART Sync Class List Server.

5. Click Stop.

SMART Sync Class List Server stops.

Restarting SMART Sync Class List Server

To start

Class List Server

from the Command

Prompt

1. Open the Command Prompt window.

2. Browse to the folder containing the SMART Sync Class List Server executable 

file.

NOTE

In most installations, this folder is %PROGRAMFILES%\

SMART Technologies\Classroom Teacher\Sync Teacher.

3. Type the following command:

SMARTSyncClassListServer.exe -start

4. Press ENTER.

SMART Sync Class List Server starts.

To start

Class List Server

from the Services window

1. Open Control Panel.

2. Double-click Administrative Tools.

3. Double-click Services.

The Services window appears.

4. Scroll to and select SMART Sync Class List Server.

5. Click Start.

SMART Sync Class List Server starts.
 



89 | CHAPTER 7  –  CONFIGURING SMART SYNC
Changing the SMART Sync Class List Server port number
The default port number of SMART Sync Class List Server is 46200. You can change 

the port number if necessary.

To change the

port number

1. Stop SMART Sync Class List Server (see page 87).

2. Open the Command Prompt window.

3. Browse to the folder containing the SMART Sync Class List Server executable 

file.

NOTE

In most installations, this folder is %PROGRAMFILES%\

SMART Technologies\Classroom Teacher\Sync Teacher.

4. Type the following command:

SMARTSyncClassListServer.exe -u

5. Press ENTER.

The SMART Sync Class List Server service is removed.

6. Type the following command:

SMARTSyncClassListServer.exe -i [Port number]

7. Press ENTER.

The SMART Sync Class List Server service is installed with the new port number.

8. Start SMART Sync Class List Server (see page 88).
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Appendix A

Language setup
SMART Classroom Suite software supports the following languages:

The components of the suite display the language appropriate to the computer’s 

location. If the computer’s local language isn’t one of the 23 that the suite supports, 

the components display English (U.S.) by default.

NOTE

If you previously installed one or more of the components of the suite before 

installing the suite itself, the installation wizard removes the components 

(including all installed languages) and then installs them as part of the suite.

• English (U.S.)

• English (UK)

• Arabic

• Chinese

• Czech

• Danish

• Dutch

• Finnish

• French

• German

• Greek

• Hungarian

• Italian

• Korean

• Norwegian

• Polish

• Portuguese (Portugal)

• Portuguese (Brazil)

• Russian

• Spanish (Spain)

• Spanish (Mexico)

• Swedish

• Turkish
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The stand alone versions of SMART Notebook and SMART Notebook SE software 

support the above 23 languages as well as others. Therefore, when you install the 

suite on a computer with a local language supported by the stand alone versions but 

not supported by the suite, SMART Notebook and SMART Notebook SE software 

default to English (U.S.) after the installation. You can download and apply the original 

language for SMART Notebook or SMART Notebook SE software by completing the 

following procedure.

To return

SMART Notebook or

SMART  Notebook SE

software to its

original language

1. In SMART Notebook or SMART Notebook SE software, select View > Language 

Setup.

The Language Setup dialog box appears.

2. Select SMART Notebook or SMART Notebook SE in the first drop-down list.

3. Click Update Languages, and then follow the on-screen instructions to download 

the desired language.

4. Select the language in the second drop-down list.

5. Select the check box to the use this language for handwriting recognition.

6. Click OK.
 



Appendix B

Customer support
Online information and support
Visit www.smarttech.com/support to view and download user’s guides, how-to and 

troubleshooting articles, software and more.

Training
Visit www.smarttech.com/trainingcenter for training materials and information about 

our training services.

Technical support
If you experience difficulty with your SMART product, please contact your local 

reseller before contacting SMART Technical Support. Your local reseller can resolve 

most issues without delay.

NOTE

To locate your local reseller, visit www.smarttech.com/where.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport 

Telephone +1.403.228.5940 or

Toll Free 1.866.518.6791 (U.S./Canada)

(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com 
 

http://www.smarttech.com/support
http://www.smarttech.com/trainingcenter
http://www2.smarttech.com/Where
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
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General inquiries

Registration
To help us serve you, register online at www.smarttech.com/registration.

Address SMART Technologies

3636 Research Road NW

Calgary, AB  T2L 1Y1

CANADA

Switchboard +1.403.245.0333 or

Toll Free 1.888.42.SMART (U.S./Canada)

Fax +1.403.228.2500

E-mail info@smarttech.com 
 

mailto:info@smarttech.com
http://www.smarttech.com/registration
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about, 2
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41
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about, 2

configuring, 20, 40, 65–68

SMART School files, 17, 37, 70–82

SMART Sync

about, 2
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89

SMART Technical Support, 93
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Technical Support, 93

training, 93

troubleshooting articles, 93

Turkish, 8, 16, 23, 91
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user’s guides, 93
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Windows Installer, 6

See also command line installation, 

SMART Install Manager

Windows Vista operating system, 19
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